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Cilj vežbe
• U ovoj vežbi korak-po-korak upoznaćemo se sa osnovnim funkcijama i radnim 

okruženjem u programu Adobe Premiere Pro, jednom od najrasprostranjenijih alata 
za nelinearnu montažu videa. Kroz praktične primere naučićemo osnovne pojmove 
digitalnog videa — formate, rezolucije, standarde i vrste kompresije — i odmah ih 
primeniti u radu.

• Praktično ćemo proći kreiranje projekta, podešavanje sekvence, izbor video standarda 
(PAL, NTSC, HD), formata slike i vrste ulazne video datoteke. Upoznaćemo glavne 
panele programa — Project, Timeline, Source Monitor i Program Monitor — i logiku 
organizacije materijala unutar radnog prostora.

• Na kraju, polaznici će moći samostalno da uvezu snimke, organizuju ih, izvedu 
osnovnu montažu i pripreme finalni izvoz (render). Adobe Premiere Pro nudi fleksibilno 
i prilagodljivo okruženje koje olakšava sve faze procesa — od uvoza do završne 
isporuke.
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• Pokrenite aplikaciju Adobe Premiere Pro.
• Po završetku otvaranja aplikacije, pojaviće se prozor u kome su ponuđene opcije: 

Recent Project (ukoliko prvi put uključujete program neće biti ponuđen nijedan 
projekat), New Project, Open Project, Help i Exit.
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1. Izaberite New Project.

• Otvoren je prozor New Project u kome se nalaze dva podmenija: General i Custom
Settings.

• U podmeniju General, u odeljcima Action and Title Safe Areas, Video, Audio i
Capture, trenutna podešavanja zadovoljavaju sve kriterijume prvog projekta.

2. Ostanite u podmeniju General, izaberite Browse.

• Potrebno je izabrati prostor na računaru na kome će Adobe Premiere čuvati svoj
projektni fajl. Preporuka je da prostor za rad ne bude na sistemskom hard disku.
Nastavnik praktične nastave daće uputsva za odabir putanje čuvanja.

3. U polju Name upišite: “prvi projekat”.

4. Izaberite podmeni Scratch Disks.
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• Pre nego što započnemo s radom, potrebno je odabrati prostor na kome će
Adobe Premiere Pro čuvati audio i video fajlove koji nastaju tokom procesa rada.
Preporuka je da hard disk na kome se čuva projekat ne bude sistemski. Zbog bolje
organizacije i snalaženja, dobro je da radni direktorijum bude na istom mestu na
kome je i projektni fajl.

5. U odeljcima Captured Video, Captured Audio, Video Previews i Audio Previews 
izaberite iz padajućeg menija opciju Same as Project.

6. Potvrdite – “OK”.

• Za razliku od ranijih verzija, Premiere Pro CS4 omogućava rad s različitim video
fajlovima, standardima, u okviru istog projekta. Potrebno je izabrati
odgovarajuću sekvencu koja je kompatibilna opremi na kojoj je materijal
snimljen.
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• Otvoren je prozor New Sequence, podeljen u 
3 podmenija. U okviru prvog, Sequence 
Presets, razgledajte sadržaje svih foldera u 
odeljku Available Presets. Odabirom bilo kog 
od ovih rešenja u prozorima Preset 
Description (s desne strane), dobićete opis i 
karakteristike svakog od ovih podešavanja.
Odabir ispravnog podešavanja od presudnog 
je značaja za nastavak rada: komfor, ali i 
kvalitet u radu!
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7. Izaberite folder DV -‐ PAL.
8. Izaberite podešavanje Standard 48kHz.

• Ovo podešavanje koristi standardni PAL videoformat, odnosa stranica 4:3, analizu 
s proredom i zvukom 48kHz (16 bita).

• Pre nego što dodelimo ime sekvenci u polju Sequence Name, pregledaćemo druge
opcije. U odnosu na podešavanje koje smo odabrali (Standard 48kHz), možemo
izvršiti neke izmene u budućoj sekvenci i prilagoditi daljem radu u podmeniju
General.

9. Izaberite podmeni General.

• Otvoren je podmeni General u kome se nalaze četiri odeljka: Editing Mode, Video, 
Audio, Video Previews.
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• U padajućem meniju Editing Mode, odabirom drugog izvornog medija u ovoj

sekvenci automatski ćete promeniti većinu podešavanja u ostalim podmenijima.
Pregledajte sve padajuće menije u podmeniju General. Većina podešavanja nema
alternativu, bez izmene osnovnih podešavanja sekvence, ali je dobro obratiti
pažnju na opciju Fields koja može imati važnu ulogu prilikom slanja finalnog rada
na drugi medij i njegovu reprodukciju (odabir analize s proredom, progresivne
analize itd.) Opciji Playback Settings vratićemo se u narednim vežbama.

• Ukoliko ste napravili nova podešavanja za početak rada na budućim sekvencama,
sačuvajte ga komandom Save Preset i dodelite mu ime. U podmeniju Sequence
Presets, u folderu Custom naći će se sva vaša podešavanja.

• U okviru podmenija General vratite sve podešavanja na početna!

10. Izaberite podmeni Tracks.
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• U podmeniju Tracks moguće je izabrati broj video i audio traka (šina) i vrstu audio

traka koju će nova sekvenca sadržavati. Kasnije izmene moguće su i nije potrebno
precizno predvideti količinu ovih traka unapred.

11. U polju Sequence Name upišite: “razgledanje”.

12. Potvrdite.

13. Pred vama je novo radno okruženje Adobe Premiere Pro, pregledajte ga.

• U verziji Adobe Premiere Pro CS4 nalazi se u predefinisanom (engl. default) 
izgledu 14 različitih panela. Svaki od njih može se privremeno isključiti pritiskom 
na “x” s desne strane imena panela.
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• Panel Project je mesto namenjeno upravljanju celinama u projektu: sekvencama,

video klipovima, audio fajlovima, slikama, grafičkim objektima.

• Panel Resource Central povezan je za Adobe onlajn bazom za učenje i preko nje je
moguće pozvati video tutorijale, PDF uputstva i sl.

• Media Browser predstavlja novinu, i omogućava pregled velikog broja različitih
video, audio, grafičkih i drugih fajlova bez uvoženja u Premiere Pro. Optimizovan
je da prikaže i komplikovane strukture fajlova bez njihovog poznavanja, poput
sadržaja P2 kartice ili BluRay diska.

• Panel Info služi da opiše bilo koji video klip, audio fajl, sliku, grafički objekat, ili
sekvencu izabranu u panelu Project ili u panelu Timeline. Daje kratak prikaz
sadržaja izabrane sekvence u pogledu trajanja i izvornog vremenskog koda
snimka.
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• Panel Effects koristi se u fazi nakon grube montaže, kada je potrebno ulepšati, ili 
unaprediti a/v(audio i video)klip. Organizovan je u pet foldera: Presets, Audio 
Effects, Audio Transitions, Video Effects i Video Transitions. Svaki od ovih foldera 
sadrži veliki broj efekata različite namene.

• Panel History, kao i kod ostalih programa Adobe-‐a, omogućava vraćanje u
nazad, na jedan od prethodnih koraka u izradi, u slučaju greške, ili ukoliko vam se
ne dopada ishod neke operacije.

• (Monitor) Source koristi se za pregledanje audio, ili video klipova i grubu 
montažu (Panel je prazan ukoliko nijedan klip nije selektovan).

• Panel  Effect  Controls  nudi  velike  kreativne  mogućnosti  u  pogledu  primene 
najrazličitijih efekata (Panel je prazan ukoliko nijedan klip nije selektovan).
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• Panel Audio Mixer predstavlja kontrolu zvuka za sve audio trake u panelu 

Timeline i za master audio traku.

• Panel  Metadata omogućava  upisivanje  najrazličitijih  pratećih  meta-‐podataka 
(podataka o podacima) u video, audio ili grafičke fajlove, primenom XMP metode.

• (Monitor) Program namenjen je pregledu rada na trenutnom projektu. tj. 
konkretnoj poziciji u sekvenci, određenoj pozicijom CTI (engl. Current Time 
Indicator).

• Panel Timeline namenjen je grafičkom prikazu montiranih sekvenci. 

• Panel Audio pokazuje izlazne vumetre master audio kanala.

• Panel Tools predstavlja mesto na kome se nalaze sve neophodne alatke za rad u 
programu.
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• U glavnom meniju Adobe Premiere Pro na PC računaru nalaze se: File, Edit,
Project, Clip, Sequence, Marker, Title, Window i Help meniji, dok na Mac
računaru postoje: Premiere Pro, File, Edit, Project, Clip, Sequence, Marker, Title,
Window i Help meniji.

14. Radno okruženje možete prilagoditi prevlačenjem jednog (ili više) panela u okna
povlačenjem za vertikalno postavljene tačkice koje se nalaze s leve strane svakog
jezička; možete im uzajamno menjati veličine postavljanjem kursora između susednih
panela i njihovim povlačenjem, a pomoću jezičaka možete pristupiti svim panelima
koji se nalaze u jednom oknu. Izmenite radno okruženje.



Vežba 1
• Kada otpočnete s prevlačenjem

panela u druge panele, pre nego što
pustite (engl. drag and drop), možete
primetiti da se pojavljuje
karakteristična plavičasta maska koja,
u zavisnosti od pozicije menja svoj
oblik. Ukoliko se nalazi po sredini
panela (kao na slici) i pravougaonog
je oblika, panel će biti postavljen
unutar postojećeg okna, a ukoliko
panel stavite u neku od strana,
trapezasta maska označava u kom
pravcu će nastati novo okno za panel
koji prenosite.
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• Nekada možete sačuvati novo okruženje, izaberite Windows > Workspace > 

New Workspace. Imenujte okruženje i potvrdite („OK“).
• Izmene u radnom okruženju Adobe Premiere Pro ne pamti i nije moguće ići 

korak po korak unazad preko komande Undo, ili putem panela History.

15. Da biste se vratili na prvobitno radno okruženje izaberite Windows > Workspace
>  Editing,  odnosno  Windows  >  Workspace  >  Reset  Current  Workspace… 
(Potvrdite).

• Editing radno okruženje koristićemo u većini vežbi.

Preko prozora Trim, počećemo proces nelinearne montaže. Kao što je već rečeno, u 
panelu Project vrši se uvoženje a/v fajlova i statičnih slika, za reprodukciju a/v fajlova i 
njihove osnovne izmene (skraćivanje, premeštanje i spajanje) zadužen je panel 
Timeline, a rad u prozoru Trim omogućava sečenje materijala.
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● Sav radni materijal dostupan je na računaru u direktorijumu:  

D:\Materijal_za_vezbe – Adobe Premiere.

16. Izaberite File > Import ili „Ctrl+I“ (PC)/„Command+I“ (Mac), i iz direktorijuma

D:\Materijal_za_vezbe – Adobe Premiere uvezite fajlove iz foldera Banka 1 (Video_1, 

Video_2, Video_3, Video_4).

17. Potvrdite (pritisnite dugme „Open“).

• Odabrani fajlovi nalaze se u Panelu Project. Odabirom polja Name
poređaćete fajlove po abecednom redu (unapred ili unazad).

18. Odvucite obeležene fajlove na traku Video 1 unutar panela Timeline.
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• Ukoliko je prikaz panela Timeline takav da niste u mogućnosti da odredite gde

se tačno CTI (Current Time Indicator -‐ indikator tekućeg vremena) nalazi
(previše uveličan ili previše umanjen), pritiskom na dugme „Zoom Out“, ili
pritiskom na (prečicu) taster „-‐“ umanjićete prikaz, a pritiskom na dugme
„Zoom In“, ili pritiskom na (prečicu) taster „=“ uvećaćete prikaz.

• Fajlove odvucite na natpis Video 1 i ukoliko se plavi jezičak CTI u trenutku
prevlačenja nalazio na samom početku panela Timeline, vaši klipovi
postavljeni su na početak sekvence. Ukoliko CTI nije bio na početku, možete
ga povući ka početku, ili pritisnuti (prečicu) taster „Home“. Sada možete
odabrati ponovo fajlove (video klipove) unutar panela Timeline i prevući ih u
pravcu CTI.
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• Ukoliko želite da se CTI nalazi na kraju, možete koristiti
taster „End“, a tasterima „PgUp“ i „PgDn“ možete
pomerati CTI unapred, ili unazad ka mestu gde je
napravljen rez između 2 kadra.

• Ukoliko korišćenjem tasterskih prečica ne postižete
nikakav efekat, panel Timeline nije aktivan (oko
aktivnog panela pojavljuje se žuti okvir), a da biste
aktivirali okvir kliknite bilo gde po površini panela.

19. Komandom Import, iz foldera Banka 1 , uvezite fajl Slika_1.
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• Adobe Premiere Pro nakon ove komande otvara novi prozor, Import Layered File:

Slika_1, zbog toga što se slika (napravljena u Photoshop-‐u), koju želimo da
uvezemo sastoji iz više lejera (engl. layerIz padajućeg menija Import As izaberite
Sequence. Potvrdite.

20. Iz padajućeg menija Import As izaberite Sequence. Potvrdite.

• Na ovaj način, fajl napravljen u Photoshop-‐u
uvežen je po zasebnim lejerima i kao celina (jedan
lejer), od njega je napravljena nova sekvenca.
Ukoliko biste odabrali opciju Import As: Merge All
Layers u panelu Project, slika bi bila uvežena kao
celina. Od ove verzije Adobe Premiere Pro,
omogućeno je uvoženjeodabranih lejera u veličini
sekvence, ili originalnog dokumenta (opcija
Footage Dimensions).
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21. Postavite CTI na kraj zadnjeg video klipa u panelu Timeline. Odaberite folder 

Slika_1 iz panela Project i odvucite na traku Video 1.

• Pažljivo prevucite folder iza CTI. Ukoliko je uključena opcija Snap, svi video klipovi
i sekvenca biće poređani u kontinuitetu. Opciju Snap moguće je aktivirati u
panelu Timeline na ikonicu Snap, tasterom „S“, ili iz menija Sequence > Snap.

• Kada je alatka Snap aktivna, video klip koji
dovlačite, ili pomerate unutar panela Timeline,
povezaće se s ivicom susednog video klipa, i
napraviti neprimetan prelaz među video klipovima.

• Kada alatka Snap nije aktivna, pomeranje video
klipa morate izvršiti vrlo pažljivo, kako ne biste
skratili postojeći klip ili napravili razmak.
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22. Postavite CTI na kraj poslednjeg video klipa u panelu Timeline. Komandom

Import iz foldera Banka 1, uvezite fajl Slika_2, Import As: Merge All Layers i
odvucite ga na Video 1 traku u panelu Timeline.

• Postavljena slika veća je od rezolucije projekta u kome
radimo (2048 x 1536 piksela). Ovakve i još veće slike
(do 4096 x 4096 piksela) omogućuju nam veću
fleksibilnost u radu, jer je slika uvek dovoljno oštra na
televizijskom ekranu.

• Manipulacijom precizne promene veličine slika
bavićemo se u okviru narednih vežbi.

23. Odaberite fajl Slika_2 unutar panela Timeline > DK (desni
klik miša) po njemu > Scale to Frame Size.
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• Na ovaj način, dobili smo uklapanje slike u projekat, jer je smanjena na
odgovarajuću veličinu (720 x 576 piksela.). Ukoliko ipak želite da vratite sliku u
originalnu rezoluciju, samo ponovite korake iz ove tačke.

24. Komandom Import, iz foldera Banka 2, uvezite fajl Audio2_1.

• Ukoliko je fajl 48000 Hz i 32 bita Adobe Premiere Pro neće imati poteškoća pri
uvoženju. Ukoliko je fajl npr. standardnog kvaliteta za CD (44100 Hz, 16 bita), ili
još nižeg kvaliteta npr. 32000 Hz s 12 bita (drugi standard DV,) program će prvo
morati da ga konvertuje u format koji mu odgovara za rad. Ova operacija može
da potraje.

25. Postavite CTI na početak panela Timeline. Odaberite u panelu Project fajl
Audio2_1 i odvucite ga na Audio 1 traku u panelu Timeline.
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• U zavisnosti od toga da li je uveženi fajl mono ili stereo, Adobe Premiere Pro

dozvoliće njegovo postavljanje na predefinisane 3 stereo trake, ili će napraviti
novu traku. Podešavanjem specifičnih audio kanala po otvaranju nove sekvence,
moguće je postaviti predefinisano više mono, stereo ili 5.1 traka.

26. Sada možete reprodukovati audio i video sadržaj koji ste postavili u panel Timeline,
pritiskom na dugme „Play/Stop Toggle“ u panelu Program, ili pritiskom na taster
„Space“. Reprodukciju ćete prekinuti na isti način na koji ste je započeli.

• Probajte tastere „J“, „K“ i „L“ za pokretanje unapred i unazad. Ovi tasteri, 
najčešće, u različitim aplikacijama za nelinearnu montažu imaju isti princip rada.

• Pritiskom na tastere strelica levo i strelica desno pomerate se za po 1 frejm.
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27. Zatvorite panele Program, Source, Effect Controls, Audio Mixer, Metadata. Na ovaj
način dobili smo prošireni panel Project u kome sada, osim naziva fajlova, možemo
videti neke njihove karakteristike. Pregledajte ih.
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28. Odaberite bilo koji fajl unutar panela

Project, npr. Video_1.avi. DK miša po njemu >
Properties. Na ovaj način možete videti sve
neophodne informacije o odabranom fajlu.

29. Izaberite Window > Workspace > Reset Current
Workspace…

30.Odaberite sve u panelu Timeline komandom Edit > Select All, ili kombinacijom
tastera „Ctrl + A“ (PC) ili „Command + A“ (Mac). Obrišite odabrano komandom
Edit > Clear, tasterom „Delete“ (PC i Mac).

31. U panel Timeline prevucite samo video klipove i audio fajl. Reprodukujte
sekvencu.

• Možete primetiti da ne postoji potpuni kontinuitet u radnji. Sada ćete to 
ispraviti.
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32. Odaberite treći video klip (Video_3), prevucite ga na

mesto drugog video klipa. Reprodukujte sekvencu.

• Ovom metodom uspeli smo da pomerimo klip na
željeno mesto, ali smo u isto vreme uništili drugi
video klip (Video_2).

33. Vratimo se korak unazad.

• U Adobe Premiere Pro postoji više načina da se vratimo korak unazad: preko
komande Edit > Undo, kombinacijom tastera „Ctrl + Z“ (PC) odnosno „Command +
Z“ (Mac), ili preko panela History u kome su ispisani svi naši dosadašnji koraci od
kako smo započeli projekat.
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34. Da bismo uspešno zamenili mesta klipovima treba 

odabrati treći video klip i uz prevlačenje na mesto 
drugog držati kombinaciju tastera „Alt + Ctrl“ (PC) ili 
„Option + Command“ (Mac). Ova operacija naziva se 
Extract & Insert Selection (Izdvajanje i umetanje).

35. Reprodukujte sekvencu.

• Ostala je još jedna montažna greška. Potrebno je skratiti drugi video klip 
(Video_3) kako bi se treći klip (Video_2) na njega logično nadovezao.

36. Postavite CTI između drugog i trećeg video klipa. Odaberite dugme „Trim“ unutar 
panela Program, ili taster „T“.
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• U levom monitoru Trim prozora 

nalazi se drugi, a u desnom 
monitoru treći video klip.

37. Kliknite preko levog monitora Trim
prozora i ulevo pomerajte kursor, dok
vam se ne učini da kadar najviše
liči na kadar u desnom monitoru, a
ukoliko je potrebno u desnom
monitoru izvršite izmenu u kontra
smeru.

38. Da biste proverili kakvu ste
montažnu odluku napravili, pritisnite
dugme „Play Edit“.
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39. Ukoliko ste zadovoljni montažom, zatvorite prozor. Ako niste, u skladu s ciljem 
koji imate, prepravite drugi, ili treći klip.

40. Reprodukujte sekvencu.

41. Sačuvajte projekat (File > Save As...) na mestu i pod imenom koje će vam dati 
nastavnik praktične nastave.
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